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Perspective Installation Guide System Requirements

SYSTEM REQUIREMENTS

The following requirements are for Perspective operating in a traditional LAN/WAN environment with the Web server component
running on a separate Microsoft® IIS box. These specs are for planning purposes only and apply to Perspective™ V.5.2, Dispatch, and
Focal Point™ V.1.2. Please contact your Resolver representative for a specific assessment of your needs.

NOTE: Meeting the Minimum system requirements means you can run the application successfully, but it may not provide the best
performance. Meeting the Recommended requirements will offer a significantly better experience.

MINIMUM
Processor Speed 2 GHz dual-core 2.5 GHz dual-core
Memory 2GB 4GB
Operating System Windows® Vista SP 3, Windows® 7 SP 1, Windows® 8.1, Windows® 10
.NET Framework Version 4.5.2

Web Browser — Launch
Perspective

Web Browser — Web

Internet Explorer® 11, Edge

Internet Explorer® 11, Edge, Chrome®, Safari® iOS 7, Android® Browser 4.2+

Portal
Third Party Applicath Adobe Reader®9.4.0+
el arty application Sun Java® Runtime Environment 7 U71, 8 U251, QlikView® Analyzer Plug-in for IE2
Mobile iOS App i0S 8,i0S 9
Officer Mobile i0S 9, i0S 10, Android 4.4, Android 5.1, Android 6.0
WEB SERVER MACHINE3 (ON PREMISE ONLY)
Available Disk Space* | 1GB 1GB
Processor Speed 2 GHz dual-core 2.5 GHz dual-core
Memory 4GB 4GB

Windows Server® 2012, Windows Server® 2012 R2

Operating System
P B >¥ IS with WebSockets enabled” and Secure-Channel configured (HTTPS/SSL)

.NET Framework Version 4.5 with HTTP and non-HTTP activation

C++ Runtime Libraries C++ 2010 SP1 Runtime Libraries (x64) 10.40219

QlikView™ Server? 64-bit Version 11.20 SR1

DATABASE SERVER MACHINE? (ON PREMISE ONLY)

Available Disk Space 2GB 20+ GB

Processor Speed 2 GHz dual-core 64-bit server dual-core or multi-processors
Memory 2GB 4+ GB

Database Server® SQL Server® 2012 SP3, SQL Server® 2014 SP1

Reporting Services SQL Server® 2012 Reporting Services, SQL Server® 2014 Reporting Services

1.  This requirement only applies if using Visual Analysis.

This requirement only applies to Perspective Focal Point. A limited QlikView™ Server license is included with Focal Point.

3. These requirements apply to systems with up to 25 users. For systems with 25+ users, contact your Resolver account manager for more
information.

4. Depending on the size of the Perspective database, more disk space may be needed for Focal Point and Workflow.

This requirement only applies if using Dispatch.

6.  Only SQL Server Enterprise Edition is supported for indexing on audit tables.

g

L4l

Notes:

Net.TCP binding on port 808 is required only if using DispatchLog.

For the best Dispatch experience, it's recommended that dispatchers run the application on two monitors with the same resolution.
For the best performance, do not run the Indexer on the same server where the database is hosted.

Deployment Note: The Perspective client is deployed as a ClickOnce application, launched from IE. It has a zero client footprint and doesn’t require

administrative rights to launch.
Network Note: If single sign-on authentication or add from Active Directory is used, Active Directory Services must be enabled on the Perspective Web

Server.
Internet Note: Internet connectivity on the Client Machine is required for full functionality.

m © Resolver Inc. Confidential. Do not distribute. Page 1 of 69



Perspective Installation Guide Standard Install

Standard Install

SQL Database Server

1. Ensure Microsoft SQL Server 2012 SP3 or better has been installed.
2. Install the Perspective database:

a. Launch Microsoft SQL Server Management Studio.

b. Right-click databases and select Restore Database.

¢.  Under From Device, click the Browse (...) button and browse to the appropriate

database: default, sample, or system.

Note: Standard backups are found in Perspective Install > Database Setup > New. If
you're unsure which database to use, contact your Perspective Administrator.

d. Click OK.
e. Check the Restore option.

f.  Enter a database name in To Database, and then click OK. The database should now

appear in the database list.
3. Create a new SQL user that will be used by Perspective to connect to the SQL Server:

a. Launch Microsoft SQL Server Management Studio. In the menu on your left, expand the
Security node, right-click Logins, and select New Login.

! Microsoft SOL Server Management Studio Express
File Edit ¥ew Tools ‘Window Community Help
. - e C—
Dvewcuery [ |[& | Sovas H @B E BB
arer -0 x = ’.] - X
2 @ E & 7 EE
Bl | f§ BETAISQLENPRESS (SQL Ser &
1 Databases .
= [ Security Lj Loglns
= [ - - TETAISQLEXPRESS| SecurityiLogins 10 Trem(s)
& F\c[ Mew Login,.. N |
x5 BY Filker S
%) BE | Created I -
fr B Repotts ¥ Trackclient 11/12/2010
%EIBL Refrash 81501 Server200SMSFTED.. . 11/7/2007
o I e8| 5QLServer2005MSSQLUL..  11/7/2007
& NT AUTHORITY} A% BUILTIM Administrators 11/7(2007
A NT AUTHORITY),
. B BUILTIN | Users 11472007
E Ea A INTERMAL\ron. Fradette 3/5/2009
d s L
£ Server Roles _: MT AUTHORITY:NETWORK SE... 11;?;200?
Credentials & NT AUTHORITYYSYSTEM 11/7/2007
—— ':J e hal N 11 dmaienng LI
1] | »
Ready A

m © Resolver Inc. Confidential. Do not distribute. Page 2 of 69



Perspective Installation Guide Standard Install

b. Inthe Login — New form, under the General page, type in the Login Name and modify
the rest of the options according to your preference.

c. Open User Mapping. Ensure the account has db_owner role membership rights, then

click OK.
E Login - New M=l E3
Selectapam \ ;—S Siript - L‘j Help
2 General
44 Server Roles L.
_"@' Uzer Mapping Uszts mapped to this logn:
24 Securables Map | Dalabase | User | Default Schema |a]
2 Stahys r miodel
¥ | PespectiveZlSample | remnyakova _IJ
r RepontServer$SOLE Rpr...
- ReportServer$SOLE xpr... LI
™| Guestacoount enatiled for: PerspectiveZ] Sample
Database role membership for: Perspective2 5 ample
Server [ db_accessadmin
BETAMSOLEXPRESS [ db_bad! ator
Connectior: [] db_datareader
INTERMNAL \svetlanaremnyakoy| | db_dataveiter
2 vi i i [ db_ddladmin
iew connection properties
[ db_derydatareader
[ db_denydataventes
[ db_secuntyadmn
Ready [ PerspectivelserRole
¥ public
Ok I Cancel |
Vi

Database Restore (Dispatch Scheduling Service and
Service Clustering)

Note: This section applies to users installing an edition of Perspective with the Dispatch application.
If you're not installing an edition of Perspective with Dispatch, skip this section.

Follow these steps below to restore both the Dispatch Scheduling Service database and the
Service Clustering database.

1. Open SQL Management Studio.

2. Right-click Object Explorer and click Restore Database.

ﬂ © Resolver Inc. Confidential. Do not distribute. Page 3 of 69



Perspective Installation Guide Standard Install

Object Explorer

Connect~ & 34 m E£

= LB 2lk7de-2012a (501 Server 11.0.2100 - sa)

= Mew Datab.
Ci ew Database...
= Attach...
u Restore Database...
U i .
T Restore Files and Filegroups...
u Deploy Data-tier Application...
l : —
— Import Data-tier Application...
u
L Start PowerShell
[+
H U Reports 3
u
u Refresh
| Perspective_43_UetaultwithLicense

[_-.J Perspective_46_2_Default

[ i Dercnactiee AR 3 Mefaull narads

1 H

3. Navigate to the location of Dispatching Schedule Service database backup file.

Note: Standard backups are found in Perspective Install > Database Setup > New. If you're
unsure which database to use, contact your Perspective Administrator.

ﬂ © Resolver Inc. Confidential. Do not distribute. Page 4 of 69



Perspective Installation Guide Standard Install

Ar Restore Database - SchedulingServiceDatabase = =5
/4 Atail-log backup of the source database will be taken, View this setting on the Options page.

Select a page S8 seript -+ | [ Help

# General

%A Files 5

= ource

&% Options

() Database:

C\temp\SchedulingServiceDatabase.bak

Database: SchedulingServiceDatabase W
Destination
Database: SchedulingServiceDatabase v
Restore to: The last backup taken (March 28, 2016 12:56:23 PM) Timeline...

Restore plan
Backup sets to restore:

Restore  Mame Component  Type  Server Database

SchedulingServiceDatabase-Full Database Backup  Database Full  2LK74V-20124  SchedulingSen

Connection
27 21kT4v-2012a [sa]

View connection properties

Progress
>

v Done
@ Verify Backup Media

4. Click OK to restore

5. Create a new SQL user that will be used by Perspective to connect to the SQL Server:

a. Launch Microsoft SQL Server Management Studio. In the menu on your left, expand the
Security node, right-click Logins, and select New Login.

m © Resolver Inc. Confidential. Do not distribute. Page 5 of 69
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Standard Install

. icrosoft SOL Server Management Studio Express
File Edit Wiew Tools ‘Window Community Help
res = [
Drevowey | |3 | St H @ BEERES
Obj ; > 1 X < ,,] - X
BYWw TE @EeTEE
Bl |} BETAISQLEXPRESS (SQL Ser = |
1 Databases i .
= [ Security D Loglns
= Lo e - ETAISQLEPRESS{Securtyilogins 10 Teem(s)
,_r." nc[ Mew Login,.. P |
| BE| Filter SN
o] BH | Created I -
x| B Renorts * Trackclient 11122010
'r;ﬂBL Refrash 50LServer2005MSETEL,, . 11/7/2007
ca IN 8\ S0LServer200SMSS0LU...  11/7/2007
" T
G NT AUTHORITY, A8 BUILTINAdministrators 11/7{2007
A NT AUTHORITY),
8 e ] BUILTIN Users 117 }2007
i Ea A IMTERNMNAL ron.fradette 3/sf2009
/ s =
3 Server Roles _: T AUTHORITY':NETWORK SE... 11;’?;’200?
Credentials A T AUTHORITYYSYSTEM 11/7/2007
—e .L_J . l A e 11 PPRINNE ;I
| | »
Feady 4

b.

the rest of the options according to your preference.

In the Login — New form, under the General page, type in the Login Name and modify

c. Open User Mapping. For both the Dispatch Scheduling Service and Service

Clustering databases, ensure the account has either db_owner OR db_datareader and

db_datawriter role me

mbership rights, then click OK.

F Login - New HE B
. paL 5 Seiipt ~ |4 Help
2 General
44 Server Roles P il
f Uzer Mapping Users mapped to this logirc
A Securables Map I Database: [ User ] Default Schema |;|
A Status r miodel
¥ Perspective2 S ample remnpakova _IJ
r ReportSenver$SOLExpr...
r ReportServer$SQLExpr... LI
I™ | Guest account ensbled for: PerspectiveZiSample
m Dratabase role membership for: Perspective215 ample
Server. [ db_accessadmin
BETANSOLEXPRESS [ db_backupoperator
Connection: ] db_datareader
INTERMNAL\svetlanaremnyakoy] ([ db_dataveiter
) . ) [ db_ddladmin
3¢ Wiew connection properties| | — derydat i
[ db_derydatawiter
[Progiess Boow
[ db_securityadmin
Ready [] Perspectivelseifiole
¥ public
0K I Cancel |
V
m © Resolver Inc. Confidential. Do not distribute. Page 6 of 69
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SQL Reporting Services

1. Ensure that SQL Server Reporting Services is installed.

2. From the Perspective install directory, copy the Reports Setup folder and all subfolders to a
temporary directory on the Reporting Services computer.

3. Edit the PublishServerReports.bat file in the temporary directory. Before making any
changes, save a backup copy of the original PublishServerReports.bat file.

e Edit databaseServerName to <Name_of_Database_Server>.
e Edit databaseName to <Name_of_Database>.

e Edit databaseUserld to <sql_User_Account>.

e Edit databasePassword to <sqlUser_Password>.

4.  Save changes and run the PublishServerReports.bat file to publish reports to the Report
Manager. If the file fails to run, see Troubleshooting Tips.

5. Browse to your Reporting Services Web site (e.g. https://localhost/Reports/).
a. On the Contents tab, click the Perspective folder.

b. Click Properties, Security and New Role Assignment, then Edit Item Security.

f:'.‘ Report Manager - Windows Internet Explorer =] E3
@A - Ié‘ http:,l’p’localhost,l’Reports,iPagas,l’FoIdar.aspx?Ilj B[4 | K IA"’Live Search R
File Edit Wiew Favorites Tools  Help
7 Favarites (& Report Manager | |
: : Home | Help =
) SQL Server Repaorting Services l =
I_j] Home > Search for:l Go
“  Perspective
X Delete || 47 New Rulenfhsswgnment| ¥ Revert to Parent Security
General &y
Security - Group or Userd Rale(s)
[T Edit BUILTIN%Administrators Content Manager
[ Edit BUILTIMYUsers Content Manager

c. Enter a Windows Service Account for the Perspective application to use when
connecting to Reporting Services. Create a new local user, if you do not have one

already. Ensure that the password is not set to expire.

d. Select the Browser role and click OK.

m © Resolver Inc. Confidential. Do not distribute. Page 7 of 69



Perspective Installation Guide Standard Install

/2 Report Manager - Windows Internet Explorer | _ (O] x|
@: - Iﬁ, http:,i,l’Iocalhost,l’Reports,l’Pages,l’EditGrDup.aspx'j R || #2 ]| % I:J Live Search RP-

File Edt view Favorites Tools Help

{I Favarites @ Repork Manager | |

Home | Heln |

rgﬁ;g SOL Server Reporting Services Search for: I—M

New Role Assignment

Use this page to define role-based security for Perspective.

Group or user name: [remnyakova

Select one or more roles to assign to the group or user.

© Roled Description

[ Browser May view folders, reports and subscribe to reports,

[T Content Manager  May manage content in the Report Server. This includes folders, reports and
resources.,

I~ My Reports May publish reports and linked reports; manage folders, reports and resources in a
users My Reports folder,

I~ Fublisher May publish reports and linked reports to the Report Server.

7 Report Builder May view report definitions.

o] (o] -

Perspective Services (Application Web Server)

Completing the following steps will install Perspective Services, Integration Services, Real Time

Services, and Web Portal.

Server Manager * Dashboard

WELCOME TO SERVER MANAGER
 Local Server
i Avservers = 'Add Roles and Features Wizard [=To |
¥ File and Storage S¢
o us

Description

> | Cancel

£\ Enable IIS 6 Metabase Compatibility (image is taken from Windows Server 2012).

£\ Ensure Internet Information Services (I1S) is installed and that 1IS has WCF Activation
turned on and, if installing an edition of Perspective with Dispatch, ensure the WebSocket
Protocol is installed (image is taken from Windows Server 2012).

ﬂ © Resolver Inc. Confidential. Do not distribute. Page 8 of 69
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Standard Install

Server Manager =

Before You Begin

Installation Type

Select server roles TVBDABPDWHSW2LX ppm2000.com

Add Roles and Features Wizard
| [' Manage  Tools  View  Help

DESTINATION SERVER

Select one or more roles to install on the selected server.

Roles Description
: : ~| 11585 and ASP.NET 4.5 support
b [E] Security (8 of 9 installed) writing server applications that
4 [m] Application Development (5 of 11 installed communicate over the WebSocket
[ .NET Extensibility 3.5 Rrosooal
V] NET Extensibility 45 (Installed)

[] Application Initialization

[ Asp

[] ASPNET 35

| ASP.NET 4.5 (Installed ~
[ cal =

7 IsA Hide

V] 1SA
[ Server Side Includes

FafwebSacket Brotocol (Installed]

b [ FTP Server .
< w >
IS 1
Ll = lanageability

Events Events vents

Services Services Services

Performance Performance Performance

BPA results BPA results

1. From the Perspective Install > Web Service Setup directory, run as an administrator

Perspective.Services.exe. To complete the setup, follow the wizard's guidelines.

a. If the User Account Control screen pop-up window appears, click Yes.

] User Account Control -

@ This file is from an untrusted location.
" Are you sure you want to run it?

Program name:  Perspective.Services
File origin: Metwork drive

() Show details Yes || N

This file is in a location outside your local network, Files from locations you don't
recognize can harm your PC. Only run this file if you trust the location.

_hange when these notfications appear

b. Wait for the Perspective Service Setup Wizard to start. Click Next.

¢. Read the License Agreement. If you accept the terms and conditions, select the

appropriate radio button, and click Next.

d. The default install path for the Complete install is C:/inetpub/wwwroot/Perspective5.2.

Ensure Complete is selected, and click Next.

e. In

the following screen, click Install to confirm the installation. Wait while Perspective

Services is being installed.

ﬂ © Resolver Inc. Confidential. Do not distribute.
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Perspective Installation Guide Standard Install

f.  If Visual C++ 2010 SP1 Runtime Libraries (x64) is not installed, you will be prompted
to install the Runtime Libraries. If already installed, skip to step 2i.

13 Perspective Service - InstallShield Wizard - ©

Installing Perspective Service
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs Perspective Service, This
may take several minutes.

Status:
Instaling Microsoft Visual C++ 2010 SP1 Redistributable Package (x64)

InstallShield

g. Accept the Terms and Agreements, and click Install.
h. When the installation is complete, click Finish.

i. Perspective Services installation will continue.

j. Click Finish once the installation is complete.

Only check the Show the Windows Installer log box if you want to see where the files
have been installed.

Set Up Secure Sockets Layer (SSL) on Internet Information Services (1IS)

To set up SSL on IIS, follow the instructions on the Microsoft IIS website.

Configure Connections Using Service Manager

1. From the Perspective Install > Web Service Setup directory, run

Perspective.ServiceManager.exe as an administrator.
a. The Install Wizard screen appears.
b. If the User Account Control screen pop-up window appears, click Yes.

2. The installation wizard appears. Click Next to continue.

E © Resolver Inc. Confidential. Do not distribute. Page 10 of 69
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Perspective Installation Guide Standard Install

a. Read the License Agreement. If you accept the terms and conditions, select the

appropriate radio button and click Next.
b. You can change the installation directory, or click Next for default file path

¢. Inthe following screen, click Install to confirm the installation. Wait while Perspective

Service Manager is being installed.
d. Click Finish once the installation is complete.

e Only check the Show the Windows Installer log box if you want to see where the

files have been installed.

From the Start menu, or desktop, launch Perspective 5.2 Service Manager as an

Administrator.

Note: This process may trigger Windows' UAC (User Access Control) security feature. If
prompted, click Yes.

-

] User Account Control -

Do you want to allow the following program to make

changes to this computer?

Prograrm name:  Perspective.ServerManager
: Verified publisher: PPM 2000 Inc

File origin: Hard drive on this computer

@ Show details Yes | | Mo

Change when these notifications appear

If you changed the installation path, you may be prompted to select a Perspective
configuration file. Navigate to the installed location of Perspective Services, select
Perspective_[Your_Business_ID].config (default location:
C:\inetpub\wwwroot\Perspective5.2\PerspectiveServices) and open the configuration

file.

Note: If you're using Perspective On Premise and your organization’s business ID is Default,

the configuration file will be saved as Perspective_Default.config.

You'll be prompted for database information.

m © Resolver Inc. Confidential. Do not distribute. Page 11 of 69
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Standard Install

Database Connection E

Ferzpective |

Connection (D

ISampIe
SOL Server

I.-'!-.S UANZIALLMNEZ2013

¥ Frimary Connection

Default Language 1D

=~

1] -
" windows Authentication
* SOL Authentication
| zernarme:
IF'erspective
Pazzword:
I. [ 11 1]
Dratabazes

Perzpective 40 Demo

5

4.  Enter a new name for Connection ID.
Note: The Connection ID cannot contain the word “Default”.
5. Inthe SQL Server lookup list, select your SQL Server or type the name of your server in the

text box.

6. Leave Default Language ID set to 0, unless instructed otherwise by Resolver.

7. Ensure SQL Authentication is selected, and enter the SQL Username and Password created

when installing the database.

Select your Perspective database from the Databases lookup list.

Note: If you receive an “Unable to connect to the named server” message, you have entered

either the wrong SQL server name or credentials.

Click OK to save and add the primary connection.

m © Resolver Inc. Confidential. Do not distribute.
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Perspective Installation Guide Standard Install

10. In the top field, enter your Company Name, as listed on the email provided to you with
your license keys.

11.  Enter the Master Key that applies to the Company Name entered. Note, the Master Key is
case-sensitive.

12. Click the Validate button. The fields below will indicate the number of active licenses,
License Expiry Date, Product Level and specifications of individual Licensed Modules (i.e.,
Product, Number of Users and Expiry Date).

Note: The Allow connections to Perspective License Service box is checked by default.
Unchecking this box means a license file must be imported when you click the Validate
button. If you don't have a license file, contact Technical Support at 1-877-776-2995.

g Perspective Service Manager |;|i-

Service Manager Settings

Company Name:
i PPM
4. Configuration | | |
B Master Key:
£ Datbase [PXPONLS1230X00 130000 | | valdate

Allow connections to Perspective License Service

™ ¢ Product Validation
&

-
R Quick Find Indexing Licensed To License Expiry:
- PPM 2000 12/31/2099
= User Defined Fields Product Level Humber Of Licenses:
Perspective EIM 1000 Concurrent
Enterprise Incident Management
i Downloads
Licensed Modules:
Product Expiry Date -
Mabile Wwieb 12/31/2099 =
FPM Partner MonConsumer 123172099
Case and Investigations 12/31/2085
Dashboard 12/31/208%
Call Taker Form 12/31/2099
Mabile Apple i0S 12/31/2099
‘web Portal 12/31/2099
Language Packs 12/31/2099
Mapping 12/31/2099 ~
Save | | Cancel

41212016

13.  Open the Database component from the menu on the left and double-click your database
name, or click the Edit button.

14. Open the Report Service tab and type the report server URL in the Report Server URL box.
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15.

16.

17.

18.

19.

20.

21.

22.

Enter the name of your Reports Folder.

Proceed to the Report Service User section below. Enter the Domain, Username and
Password that were granted browser rights when setting up the server-side reports.

Click the Test button. You should receive a prompt telling you the URL is valid. If not,
confirm your configuration is correct and try again. Please refer to troubleshooting section
for SQL reports if you receive an error and message.

Click OK.

Database Connection B I

F'erspeu:tivel &nalysiz Expert Connection Report Service |.-'-‘«uthentiu:atiu:|n Mu:udel

— Report Service Host
Report Server URL

|hltp:ffmyserver;"repnrtsewer Test... |

Feports Folder

|F'erspeu:tivel

— Report Service Uszer
Cromain

IU zer_Domain_Mame

lJzemame

ILlser_Lcugin_N ame

Pazsword

(1] 4 Cancel

Select the Configuration component from the Perspective Service Manager menu.
To encrypt the Perspective_Default.config file, check the Encrypt Configuration? box.
Open the Client-Side Configuration tab.

Enter the Download URL for Client-Side Reports, if needed, for the client reports
configuration files to update automatically (i.e., https://<servername>

name>/perspectiveservices/client).
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./ Configuration _,--1{ Client-Side Configuration r Notification ]/ Altachments l Setvices l AE Tools 1

Client R epats Configuration

Download URL for Chent-Side Reports:
lhhp: /locahost/perspectiveservices/chent/

Location of updated chent-side reports:

| Browse |

r Reports Exists On Senver

Client-Side Reports Versi...

401126

Save Cance!

23. Click Save.
Note: If you do not click Save, you will be prompted to save all changes that have been made.

24. Close the Service Manager by clicking the Cancel button, or clicking the X button on the
caption bar.

25. Restart IIS.

4\ Advanced Configurations Warning
Additional options in the Service Manager are not covered in this step-by-step Standard
Install walkthrough. For the list of supported advanced setup configuration options,
please, refer to the Advanced Configurations section. It's recommended that all setups
follow the standard setup procedures outlined in this section as an initial starting point.
Advanced features can be configured as needed after the standard configuration has

been verified to run correctly.
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Scheduling Services

Note: This section applies to users installing an edition of Perspective with the Dispatch application.

If you're not installing an edition of Perspective with Dispatch, skip this section.

1.

Navigate to install location of the scheduling service. If you completed a default installation
of Perspective Services, it's located at C:\Program Files\Resolver
Inc\Perspective\5.2\Dispatch Scheduling Service. If you completed a custom installation,
this location is the path that was specified in the InstallShield Wizard.

i Perspective 5.0 Service - InstallShield Wizard -

Custom Setup

Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

- - Feature Description
Perspective Services .

Intearation Servi Creates scheduled dispatches,
MIEGraton Services purges dosed dispatches and
Real Time Services removes entity locks.

Web Portal

=B [oispatching Scheduie Service|

This feature requires 14ME on
your hard drive,

Install to:
C:\Program Files\Resolver Inc\Perspective\5. 0\Dispatch Scheduling Servicel,
InstallShield
| Help | | Space | | = Back ” Mext = | | Cancel |

Open the Connections.xml file.

Enter the service folder information to show the Integration Services virtual directory (i.e.
<servername>/integrationservices).

Note: If Scheduling Services and Integration Services are installed on the same machine, the
Service Folder element(s) in the Connections.xml file must contain either an IPv4 address or
the localhost alias.

Save your changes to the Connections.xml file then close.

Open the SchedulingServices.exe.config file.
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6. Under appSettings. enter the database connection string to point to the Scheduling Service
database. For example:

<add key="DataBaseConnectionString"” value="Data
Source==<dbserver\dbinstance>;Initial Catalog=<dbname>;user
id=<user>;password= <password>;Application Name=Integration Services" />

7. Save your changes to the SchedulingServices.exe.config file then close.

8. Open Windows Services.

9. Click on Dispatching Schedule Service.

: Services
File Action View Help
e EEoE He »mnw
., Services (Local) O i {Local)
Dispatching Schedule Service Name - Description Status Startup Type Log On As ~
£ Device Install Service Enablesa c... Manual (Trig.. Local Syste..,
Start the service i Device Setup Manager Enables the ... Manual (Trig... Local Syste...
%5 DHCP Client Registers an... Running  Autematic Local Service
Description: . Diagnostic Policy Service The Diagno... Running  Autematic (D.. Lecal Service _
Creates scheduled dispatches, purges < Diagnostic Service Host The Diagno... Manual Local Service =
closed dispatches and removes entity 7, Diagnostic System Host The Diagno... Manual Local Syste...
ID(k.S' It this SETVICE 15 stopped, these agnostics Tracking Service  The Diagno.. Running  Automatic Local Syste...
services will not function properly. - -
4 Dispatching Schedule Service Creates sch... Local Syste...
. Distributed Link Tracking Cl... Maintains li... Running  Autematic Local Syste...
. Distributed Transaction Co... Coordinates.. Running  Automatic (D... MNetwork 5.
7, DNS Client The DNS Cli...  Running  Automatic (T... Network 5.,
% Encrypting File System (EFS)  Provides th.. Manual (Trig.. Local Syste...
. Extensible Authentication P...  The Extensi.. Manual Local Syste...
" Function Discovery Provide... The FOPHO... Manual Local Service
% Function Discovery Resourc... Publishes th... Manual Local Service
% Group Pelicy Client Theservice .. Running  Autematic (T.. Local Syste..
i Health Key and Certificate ...  Provides X.5... Manual Local Syste...
S5 Human Interface Device Ser... Activates an... Manual (Trig.. Local Syste...
i Hyper-V Data Exchange Ser.. Providesa.. Running Manual (Trig... Local Syste..
4 Hyper-V Guest Service Inter... Provides an ... Manual (Trig... Local Syste...
% Hyper-V Guest Shutdown 5., Providesa.. Running Manual (Trig... Local Syste..
% Hyper-V Heartbeat Service Meonitors th.,  Running  Manual (Trig... Local Syste.. w

\ Extended /(Standard/

10. Click the ¥ icon or right-click Dispatching Schedule Service then click Start.

Real Time Service Configuration (DispatchLog)

If you're installing a version of Perspective that includes DispatchLog, additional configuration to

Real Time Services is required.

1. Navigate to your IIS Settings.

2.  Expand Site and expand Default Web Site.

3. Right-click PerspectiveRealTime then Manage Application >Advanced Settings.

4. In Advanced Settings, add http,net.tcp in Enabled Protocols. Click OK.
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e Port 808 is used by default.

L Internet Information Services (1I5) Manager [=]o] x|
® [& v quzsc + Agplication Pools Advanced Settings | @
Fle View Help 4 (General)
=T q Apph Phiysical Path Cinetpub\wwwroot\Perspective\Se =
Q- Hix 8 E Physical Path Credentials @ Add Application Pool..
j 3? StartPage This page lets you Physical Path Credentials Logon ClearText ociated with Set Application Pocl Defaults..
4- :ip“?ﬂw:?ﬁ o worker processes, Preload Enabled False - Application Pool Tasks
e :”"' ——— Fiter Virtual Path PerspectiveRealTime b oSt
4 [l Sites . - 4 Behavior - B Sto
4 40 Default Web Site Name . Ppplications P
b aspnet_client 2% NET vd.5 LR o g net.tcpl & Recycle.
@ ¥ &
b - IntegrationServieed | 5} NET vd.5 Clas] Edit Application Pool
b -[] Perspective ¥ DefauappPol 1 2 Basic Settings..
3 ? PerspectivePortal || 3 |ntegrationSed 1 Reeycling...
’ ,: PerspectiveReallin | 3 perpsectivere i Advanced Settings...
I -[:¥ PerspectiveService JPmpmino h o
¥ PerspectiveS u
&S Ferspectmese X Remove
View Applications
@ Help
Online Help
Enabled Protocols
Ensbled Protocols specifies the protocols that requests can use to aceess an
application. The default value is 'http', which enables both the HTTP and ...
<[ |»
I =
< i 5] [ Features View
Ready o,

5. Go to the inetpub/wwwroot/Perspective5.2/PerspectiveServices directory and edit the
Perspective Default Config file. To do this, find the Perspective Real Time URL, and replace
the localhost with a fully qualified server name.

Note: Additional exceptions for Windows and network firewall may be required.
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Client Machines

Accessing Perspective Desktop Client

1. Ensure Microsoft .NET 4.5.2 Framework is installed on the client machine.
2. Browse to the Perspective Services URL:

e  https.//<servername>/PerspectiveServices <servername> refers to the Perspective
Web server installed in the previous section.

a. Click the Perspective icon.

PERSPLECTIVE:

rlolols

Perspective Dispatch Dashboard Portal

Incidents & Investigation Managing Events in Real Time Personalized Visual Metrics Web based Security Central

b. Click Run.
c. Ifyou're using the MSI Package installer, follow the procedures below.
i. Browse to the Perspective Services URL:
https.//<servername>/PerspectiveServices/?opt=0
If you're using 2opt=1, only the ClickOnce installer will be displayed.

If you're using 2opt=0 or if Java Script is disabled or the Web Service is not a
trusted site, both the ClickOnce and MSI Package installer will be displayed.

ii.  Download the MSI Package and follow the on-screen instructions. If you
experience any problems during the download of the MSI Package or the
installation of the MSI client, call Technical Support at 1-877-776-2995 for

assistance.
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Note: Following the configuration of the Web Server, please ensure application
initialization has taken place so that end users do not experience delays with initial page
loading. After any IIS reset or configuration, navigate to
https://<servername>/IntegrationServices/service.svc to begin the application
initialization.

3. After Perspective downloads and installs, you might be prompted to enter a URL. The URL
should be automatically populated.If so, move to the next step. If not, enter your Perspective
Services URL as before: https://<servername>/PerspectiveServices. <servername> refers
to the Perspective Web server installed during the installation of Perspective.

Now you should be able to test the default Perspective logon. From this point onward, users
must navigate to the Perspective Services URL to launch the Perspective application.

Perspective Default Logon

User Name: Admin
Password: Security

To create a shortcut to the application on the client machine’s desktop, proceed as follows:
1. Navigate to the Perspective Services URL.
2.  Right-click the Launch Perspective button and select Copy Shortcut.

3. Right-click the client desktop and select Paste Shortcut.

2\ Default Admin Master vs. Users with Administrator Rights

As of Perspective Version 3.3, there are differences between the default Admin Master
account and a Perspective User with Administrator rights. Specifically, the Admin
Master has select features available that other Users, even with Administrator rights,
do not.

However, the default Admin Master can only access the Administration and
Dashboard panels of Perspective. Other components are unavailable to the Admin
Master; this account cannot be used for data entry.

Accessing Perspective Web Portal

Please refer to the Section titled, Integration Services for more information. Users can't access
Portal until an administrator has set up workgroups within Perspective that allow imports. Once
the workgroups are set up, the Web Portal can be configured.
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To configure your Web Portal:

1. Open an Internet browser (either Google Chrome v29 or greater, or Internet Explorer 11 or
greater.

2.  Click Portal on the launch page or navigate to your Portal Services URL:

https://<servername> /PerspectivePortal. <servername> refers to the web server installed
during the installation of Portal.

3. Administrators will be required to log in to set up the Web Portal. Refer to the Perspective
Web Portal User Guide for additional information.
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Testing Perspective Implementation

Once you have completed the steps outlined on the previous sections, please go through the
following steps to ensure that all Perspective’s components have been set up properly.

Note: Following the configuration of the Web Server, please ensure application initialization has
taken place so that end users do not experience delays with initial page loading. After any IIS reset
or configuration, navigate to https://<servername>/IntegrationServices/service.svc to begin the
application initialization.

1. Go to the Perspective Services URL and confirm that the page loads properly:
https://<localhost>/perspectiveservices, where <localhost> is the appropriate local host
address on your network.

2. Go to the Perspective Services page and confirm that the page loads properly:
https://<localhost>/perspectiveservices/service.asmx, where <localhost> is the
appropriate local host address on your network.

3. Go to the Report Manager page and confirm that the page loads properly:
http:// <reportservername>/reports, where <reportservername> is the appropriate
address for the reports server on your network.

Note: If your Report Manager page does not display correctly, run the
PublishServerReports.bat file included in the Perspective Install > Reports Setup folder.

- |0

SN -
(\/:D‘\'?/d & httpsi// reportsservername fReports/Pages/Folderaspx O~ C|| & Home - Repart Manager ‘ | N & It

Home | My Subscriptions | Site Settings | Help

SQL Server Reporting Services

x|
“& Home

Sear | R
4 New Folder 44 New Data Source E<jj Report Builder [ Folder Setlings 1 Upload File 1 Details View
| -
G Perspective

4.  Log on to the Perspective client—preferably not on the server itself—using your Perspective
administrator user name and password.

5. Once you have logged on successfully, click on the Reports button in the Navigation pane
(on the left-hand side of the screen) and confirm that all reports are listed. The easiest way
to confirm that the client-side reports are working is to verify that there are reports listed
under the Detail Reports heading, such as the Incident, Person and Vehicle Reports.

6. To also confirm you are connected to the correct database, run the Workgroup List report
and verify the workgroups listed.

7. To confirm that the server-side reports are working, try running the Test Report under the

<Administrative Only> node listed. If you receive an error message, see the
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Troubleshooting Perspective & SQL Reporting Services article on the Resolver Support
site for more information.

Note: Both the Report version and database version should display as 5.2.
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Advanced Configurations

Perspective offers your organization a number of advanced configuration options. Before

standard installation first, then contact Technical Support at 1-877-776-2995 or
support@resolver.com for further instructions.

SSL on Your Web

Service

To secure and encrypt data sent to and from the Web service to

client machines.

Windows Authentication

To allow users to log on to Perspective and to connect to SQL
service using their Windows authenticated account

IIS Compression

To compress information sent from Web services to the client.
(Recommended for installs with remote users who are not
connected directly to the network. If all users are internal,
compressing data may take longer than sending uncompressed
data over a high-speed network.)

Transparent Data
Encryption

For encrypting data at rest (for use with Microsoft SQL Server
Enterprise Edition only).

Setting up
Sample/Training
Database

Default setup supports one database only. If additional
databases are required, these can be set up with assistance
from Technical Support.

AE Mirroring

For sites with high volumes of data that require SQL intensive
searches to be executed against a separate SQL server.

Custom Pagination

By default, the pagination feature is set to 100 records per page.
This number can be modified (to any value from 20 to 1000
records per page) by manually editing the
<PaginationPageSize>100</PaginationPageSize> tag in the
Perspective_Default.config file.

Custom Legal Notice

and Privacy Statement

To customize Perspective’s legal notice and/or privacy
statement for your organization, navigate to the Legal folder in
the Perspective Services Virtual Directory, open the
LegalNotice.mht or PrivacyStatement.mht file in an HTML editor
(such as Microsoft Word), apply your edits, and save the file as

an MHTML document with the original file name.
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To change the default installation location, select Custom from
Change Default Install the Setup Type screen (when installing Perspective Services).
Location Click Next. Select a feature and click the Change button. Then,
pick the new install location. Click Ok.

The caching duration is set by default to 20 minutes. However,
this can be changed by accessing the web config file of
Change Caching Options | Perspective Portal. The duration is in minutes, and can be

of Portal between 1-1400 minutes.

Note: Caching should always be enabled, unless you are
troubleshooting. Disable it by setting caching=false.

Directing to Fully Go to C:/inetpub/wwwroot/Perspective5.2/PerspectivePortal
Qualified Servers for and edit the web config file. Find the external web address and
Portal update it to a fully qualified server.

Set Up Additional Features Using Service Manager

Perspective Service Manager is an external application available only on the Web server hosting
Perspective services. It is used to manage configuration files, databases, licenses and keys, as well
as to set up a number of important features in Perspective (i.e. email and mass notifications,
attachments, Quick Find indexing, User Defined Fields, Custom Search integration and Integration
Services URL).

To access Perspective Service Manager, go to C:\Program Files\Resolver Inc
Inc\Perspective\5.2\ServiceManager > Perspective.ServerManager or open it from the
Startup menu.

Remember to complete each editing action in Perspective Service Manager by clicking Save
Changes. To implement your settings in Perspective, restart Internet Information Services (I1S)
(and the Perspective Web server). Note that restarting IIS will affect anyone currently logged on to
Perspective. Ensure that all users have saved their work and exited the program prior to
completing this step.

Configuring HTTP Compression for ClickOnce
Packages

Configuration: Windows Server 2012R2
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1. Verify that Static and Dynamic Content Compression Roles are enabled (done through

server manager).

[= Add Roles and Features Wizard - | o[

DESTIMATION SERVER

Se ‘ ect server ro | es DEV2012R2-01.0pm2000.com

Select one or more roles to install on the selected server,

Roles Description
Server Selection L s m e e A~ Performance provides infrastructure
[[] Remote Access for output caching by integrating

the dynamic output-caching
capabilities of ASP.NET with the
static output-caching capabilities
that were present in 1IS 6.0. 15 also
lets you use bandwidth more
effectively and efficiently by using
common compression mechanisms
such as Gzip and Deflate.

[[] Remote Desktop Services

[ Velume Activation Services

FIRYIRPerformance (Installe

; Application Development (Installe
p [ FTP Server
[] IS Hostable Web Core

£ m »

< Previous | | Mext » nsta Cancel

2. InlIS Manager, click on your server.
3. Under IS, click Compression.

4.  Verify the Enable dynamic content compression and Enable static content compression

checkboxes are selected.

Connections
- [}
. € Start Page
€] DEV2012R2 (INTERNAL\stefan.krupa)
-2} Application Pools Enable dynamic content compression
I -[@ Sites

QQI Compression

Use this feature to configure settings for compression of responses. This can improve the perceived performance of a website greatly and reduce bandwidth-related charges.

Enable static content compression

Static Compression

Only compress files larger than (in bytes):

Cache directory:

SeSystemDrives\inetpubltemp\ IS Temporary Compressed Files | El

Per application pool disk space limit (in MB):

100

5. InlIS Manager, click on your server.

6. Under lIS, click MIME Types. Here you can see all file extensions and their associated MIME
Types. The basic MIME Types for ClickOnce deployment are:
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.application —> application/x-ms-application
.manifest —> application/x-ms-manifest
.deploy —> application/octet-stream

7. For the above MIME Types to be compressed, you need to edit the applicationhost.config
file which can be found in the %windir%\system32\inetsrv\config folder.

8.  Open this file. Under the http compression tag and under dynamic types and static types,
add:

<add mimeType="application/octet-stream" enabled="true" />
<add mimeType="application/x-ms-application" enabled="true" />
<add mimeType="application/x-ms-manifest" enabled="true" />

<httpCompression directory="%SystemDriveX\inetpub’temp\IIS Temporary Compressed Files"»

<scheme name="gzip" dll="XWindir¥\system32\inetsrvigzip.dll" />

<staticTypes>
<add mimeType="text/*" enabled="true" />
<add mimeType="message/*" enabled="true" />
<add mimeType="application/javascript" enabled="true" />
<add mimeType="application/atom+xml" enabled="true" />
<add mimeType="application/xaml+xml" enabled="true" />
<add mimeType="application/octet-stream” enabled="true" />
<add mimeType="application/x-ms-application"” enabled="true" />
<add mimeType="application/x-ms-manifest” enabled="true" />
<add mimeType="%/*" enabled="false" />

<fstaticTypes>»

<dynamicTypes>
<add mimeType="text/*" enabled="true" /»
<add mimeType="message/*" enabled="true" /»
<add mimeType="application/x-javascript"” enabled="true" />
<add mimeType="application/javascript" enabled="true" />
<add mimeType="application/octet-stream” enabled="true" />
<add mimeType="application/x-ms-application” enabled="true" />
<add mimeType="application/x-ms-manifest" enabled="true" />
<add mimeType="*/*" enabled="false" />

</dynamicTypes>

</httpCompression»

9.  Run Command prompt as an Administrator and execute this command. This command will

cache every file instantly:

%windir%\system32\inetsrv\appcmd.exe set config -

section:system.webServer/serverRuntime -frequentHitThreshold:1

10. Reset IIS.
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Configuration

Select the Configuration component from the Perspective Service Manager menu and open the
Configuration tab. Click Browse to navigate to the Location of Server Configuration File.

Note: This option would be used when Perspective Services has been installed in a different location
than the default option.

= Perspective Service Manager = =] -
e ing Configuration r Client-Side Configuration r Matification r Lttachments r Services r AFE Tools ]
‘ \ 5 Configuration ‘ Location of Server Configuration File
S Clinetpubiwwwroot\Pers pectived 6\PerspectiveServices'\Perspective_DEFAULT .config
?E: Database [] Encrypt Corfiguration?
';_j Product Validation QA Advanced Security PCOSEIM25
. Version: 4 61512
R Quick Find Indexing
User Defined Fields
i Downloads

Client-Side Configuration

1. Select the Configuration component from the Perspective Service Manager menu and open
the Client-Side Configuration tab.

2. To update the configuration with a .zip file provided by the Technical Support, click Browse
to navigate to the Location of Updated Client-Side Reports. The field below will indicate
the Version of the client-side reports.

3. Click Update Reports to Server to complete the update.

Note: This option would be used if a newer version of client-side reports is available.
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Coniuaaion ) Clent Sde Conbiuaation | Notiaton | Attachments | Services | 4E Taaks |

Chent Reports Configuration

Download URL for Chentside Reports:
[Nlp //<servemamed /petspectiveservices/chent/

Locabon of Updated Chentside Reports:

! __Bome |

I™ Reports Exist on Server

Chentside Reports Version
{4.01128

1 Save Changes Ext

SAML 2.0 Authentication for SSO

The following section provides instructions on configuring Perspective Service Manager to
implement SSO, however, prior to completing these steps, you must confirm your identity
provider (IdP) supports SAML 2.0 through service provider initiated SSO. SSO is supported for
use with the Enterprise edition of Perspective.

Your IdP will also need to provide you with instructions on adding and configuring new and
existing Perspective users directly through their service as |dP configurations will vary.

NOTE: If you're using AD FS to configure SAML, see the Set Up SSO with AD FS article on the
Resolver Support site for instructions after following the steps below.

1. Open Service Manager.
2. Click Configuration in the pane to the left if it's not already open.
3. Select the Configure Service Provider checkbox.

4. Enter your Perspective Services URL in the Perspective URL field, then click Validate.

Note: The URL you enter in this field must exactly match what has been entered into your
IdP’s configurations, including the case (upper-case or lower-case letters) and slash (/ or \)

direction.

5. Enter the server certificate file name in personal exchange format (.pfx) in the Certificate

File Name field and enter a password in the Certificate Password field. For testing
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purposes, a sample .pfx file has been included in the installation package with a file name of
sp.pfx and a password of password. This information is required so that the services
(Perspective, Dispatch, Dashboard, etc.) can securely communicate with the identity
provider.

6. Save a copy of the certificate file to
*PerspectivelnstallationPath*\PerspectiveServices\SAML\Certificates. This file usually
has a .PFX extension and will also need to export the private keys.

Note: If you chose the default certificate file, the file was saved at this location during
installation.

£ Perspective Service Manager \;‘i-

Service Manager Settings

Configuration I/ Client-Side Configuration r Notification ’/ Attachments r Services ’/ AE Tools

'_\ c‘ Configuration Location of Server Corfiguration File
LS C:\inetpub'wwwroot 5 P\ Perspective Services \Perspective_Default corfig
;‘ Datsbase [] Encrypt Configuration?
"} Product Validation QA Advanced Security PCOAEIM25
i
_ Version: 5.2.0.51
R Quick Find Indexing
User Defined Fields [] Enable Cliert Side Application Insights

Corfigure Service Provider. This is required if you want to use SAML authertication.
i Downloads

Perspective URL (eg: https://ACME Mylncidents.com,/Perspective Services ):
|Hrlps:ffexarnple.ppm2DDD.com;’Perspec‘tiveServices | | Walidate URL
Certificate File Name:

[sp i |

Certificate Password:

| |

After completing the above steps, you'll need to select how you will input the identity provider's
details. See the Identity Provider Configuration section for information on uploading a
metadata file or metadata URL or see Manual Settings for instructions on inputting the data
manually.

Identity Provider Configuration

The settings below allow you to import your IdP’s configurations directly into Service Manager via
a metadata file or metadata URL, which is obtained from your IdP.

1. In Service Manager, click Database in the pane to the left.

2. Double-click a database to edit it.
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3. Click the Authentication Mode tab.
4. Select the SAML Authentication checkbox.

Note: If this option is unavailable, the service provider information has not been properly
configured in steps 3 and/or 4 in the section above.

5. Select how you want to input the identity provider information:

e Metadata file: This option will require that you obtain a metadata file from your IdP
to import the SSO configurations into Service Manager. When downloading a
metadata file from your IdP, the certificate is usually extracted and saved in your My
Documents folder, but it must be moved to
*PerspectivelnstallationPath*\PerspectiveServices\SAML\Certificates after it's
been downloaded.

To use this option, after downloading the file, enter the name of your IdP in the
Description field, which will appear to users with the phrase “Login with [IdP]” on
the login screens, then click Choose File to upload the metadata file.

Database Connection .

| Perspective | Analysis Expert Connection I Report Service | Authentication Mode I—

Perspective Authentication
SAML Authentication

(® Metadata file ) Metadata URL () Manual settings

Description
| Example

e Metadata URL: This option will require that you obtain a metadata URL that will
import the SSO configurations into Service Manager. After obtaining the URL, enter
the name of your IdP in the Description field, which will appear to users with the
phrase “"Login with [IdP]” on the login screens. Enter a valid metadata URL from your
IdP in the Metadata URL field, then click Import. The URL will import the required

configurations and should be similar to the following:

https.//adfs.example.com/FederationMetadata/2007-06/FederationMetadata.xml
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6.

Note: The URL you enter in the Metadata URL field must exactly match what has
been entered into your IdP’s configurations, including the case (upper-case or lower-
case letters) and slash (/ or\) direction.

Database Connection .

| Perspective | Analysis Expert Connection I Report Service | Authentication Mode I_

Perspective Authentication
SAML Authentication

() Metadata file @ Metadata URL () Manual settings
Description

|Examp|e

Metadata URL
|I'rrtps:ffadfs.e:-:ample.ccumfFedemtiu:unMetadatafEDD?—DEfFedemt| | Import

Click OK, then save your changes.

Manual Settings

If you're not importing metadata via a file or URL, you must configure your IdP’s settings

manually. Contact your IdP for instructions on obtaining the required information.

1.

In Service Manager, click Database in the pane to the left.
Double-click a database to edit it.

Click the Authentication Mode tab.

Select the SAML Authentication checkbox.

Note: If this option is unavailable, the service provider information has not been properly
configured. See the Identity Provider Configuration section above for more information.

Select the Manual settings option.
Complete the following fields:

e Description: The name of your IdP, which will appear to users with the phrase “Login

with [IdP]” on the login screens.

¢ Name: The exact name of the IdP as provided by the IdP.
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o Partner Certificate File: Used to verify the assertions have come from the IdP. This
file must be saved to the
*PerspectivelnstallationPath*\PerspectiveServices\SAML\Certificates folder.

¢ Single Logout URL: The URL from which the IdP accepts logout requests.
¢ Single Sign On Service: The URL from which the IdP accepts SSO requests.
¢ Name ID Format: The username format provided to the IdP.

¢ Single Sign On Service Binding: The binding used by the IdP to authenticate
(usually HTTP Redirect).

¢ Sign Authentication Request: Select this checkbox if the authentication request
should be signed.

¢ Sign Logout Request: Select this checkbox if the logout request should be signed.

¢ Sign Logout Responses: Select this checkbox if the logout response should be
signed.

e Sign Assertion: Select this checkbox if the assertions should be signed.

o Encrypt Assertions: Select this checkbox if the assertions should be encrypted.
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7.

Database Connection .

| Perspective | Analysis Expert Connection | Report Service | Authertication Mode I—

Perspective Authentication
SAML Authentication

() Metadata file () Metadata URL ® Manual settings
Description

|Exam|:|le |

MName

|I'rl't|:|:ffadfs.E:xample.ppm2DDD.cum!adfsfsewit| [] Sign Authentication Request
PartnerCerificateFile [ ] Sign Logout Request

|555EFIFF58ABEXAMPLE28D283123634 cer | [] gign Logout Response
Single Logout Service Ud
|I'rl'tps:ffadfs.example.pmeDDD.cDmfadfsﬂs |
Single Sign On Service Ud

[] Sign Assertion
[] Encrypt Assertion

|I'rl'tps:fx"a-:lfs.example.pmeDDD.cumfadfsx"ls | | Export Metadata
Mame |0 Format

Windows Domain Gualified Name v|

Single Sign On Service Binding
|HTTP Redirect vl

QK Cancel

Click OK then save your changes.

Export Metadata

Once you've completed the configurations in the previous sections, your IdP will likely require

Perspective metadata in order to complete the SSO process. This information can be exported

into a file using the Export Metadata tool in Service Manager.

1.

In Service Manager, click Database in the pane to the left.
Double-click a database to open it.

Click the Authentication Mode tab.

Select the Manual Settings option.

Click Export Metadata.
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6. Navigate to the *PerspectivelnstallationPath*\PerspectiveServices\SAML\Certificates
folder, or an alternate location you may have selected in the previous section.

7. Select a file name and location to export the metadata.

Note: It's recommended that you save the metadata file in
*PerspectivelnstallationPath*\PerspectiveServices\SAML\Metadata in the Perspective
services installation directory.

8. Click OK and the metadata file will be opened. Either upload a copy of this file to your IdP
server or save a copy in the
*PerspectivelnstallationPath*\PerspectiveServices\SAML\Metadata folder if you did not
choose that location in step 6.

Perspective Configurations

Once the Service Manager and IdP configurations are complete, a Perspective administrator must
enter each user's SSO username (as it's configured in the IdP’s settings) in the Corporate ID field
by going to Administration > Users > User Details.

Linked Person Fole

) Bernard, Milly R CGJ > Chief Security Officer (Director] -
First Mame Last Mame

Milly R Bernard

Perspective Logaon 1D Comparate 1D

ets2 millybernard
Change Password Approved By

[ ] Change Password On Login ! El‘:'lj Pa

See the Perspective Administrator’s Guide for more information on entering this information in

a user's profile.

Integration Services

Integration Services should not require any additional configuration as all SAML authentication

information should be in the Perspective configuration file.
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Service Clustering

Note: These configurations apply only to users installing Perspective with the Dispatch application. If
you're not installing Dispatch, skip this section.

The following are optional advanced configurations available to users employing the Dispatch
application. In order to complete these advanced configurations, the service cluster database
must first be restored on the database server (see Database Restore for more information).
Additionally, Perspective Services, including Integration Services, must be deployed on the web
servers.

1. Navigate to the install directory of Integration Services. By default, the directory is located
at C:\inetpub\wwwroot\Perspective5.2\IntegrationServices.

2. Open the web.config file.

3. Under appSettings, make changes as needed to the following settings for deployed web

server:
. PerspectiveConfigFilePath: The physical path where Perspective Services is
deployed.
. ServiceClusters: Enter true or false to enable or disable service clustering for
Dispatch.

. ClusterServiceURL: The Integration Services URL (DispatchSystem service) of the
node within the cluster. This URL must be accessible by other nodes within the

cluster in order for service clustering to work.

4. If the ServiceClusters value is set to true, the database connection must be added to point

to the service clustering database. For example:

<add name="Perspective.IntegrationService.Properties.Settings.SystemDatabase"
connectionString="Data Source= <dbserver\dbinstance>;Initial
Catalog=<dbname>;user id= <user>;password= <password >;Application

Name=Integration Services” />

Note: Avoid making changes to other cluster-related app settings, including:
e ClusterDatabaseLockTimeoutMilliseconds
o ClusterRegistrationHeartbeatIntervalMilliseconds

o ClusterRegistrationTimeoutMilliseconds
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e InitialMasterCacheTimeOutMilliseconds
e PeerHeartbeatIntervalMilliseconds
e PeerReceiveBufferSize

Any inconsistencies on these values between two nodes within the cluster may cause issues

with service clustering.

5. Save your changes in the web.config file then close.

Email Notifications

In Perspective, users may send email notifications containing incident or case details or report
attachments through Simple Mail Transfer Protocol (SMTP). Otherwise, email notifications may
be sent when new investigators are assigned to an investigation or when assignments are created,

modified, or completed.

To set up email notification options, select the Configuration component in the Perspective
Service Manager menu and open the Notification tab. Alternatively, the email function can be
disabled by selecting the Do not use mail options radio button.

Connect to an External SMTP Server

To use an SMTP server to send emails from Perspective, select the SMTP radio button and enter

the appropriate information for connecting to the SMTP server:

o Host: The domain name of the SMTP service.

. Port: The port the SMTP service will be listening on for connections.
o Username: A valid username to connect to the SMTP service.

o Password: The appropriate password for the username.

. Enable SSL: Select this option to encrypt the SMTP connection with Secure Socket Layer
(SSL).

o Reply Address: By default, the SMTP service will include the address entered in this field
when sending emails, unless the Person who is currently logged in has an email address

saved on their record.
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. Force all emails from this address: Selecting this checkbox will force all emails sent from
Perspective to use the Reply Address as a return email address, even if the currently logged

in Person has a primary email address saved on their record.

The email settings outlined above will be used as system defaults for every client.

% Perspective Service Manager |;|£-

R ings Configuration I/ Client-Side Configuration E I/ Attachments ’/ Services ’/ AE Tools
-_-\ J Configuration () Do not use mail options.
= ® SMTP
?- Database
A Host:
l‘::‘j Product Validation |mail.ppm2DDD.com
== Port:
R Quick Find Indexing
— Usemame:
User Defined Fields ||35\-’ |
Password:
l Downloads |""" |
[] Enable SSL
Reply Address:
|n0-reph.r‘| @myincidents.com

Force all emails from this address.

Save ‘ ‘ Cancel

12/4/2005

Uploading Attachments

Perspective allows users to attach any file type to any data record in the application. These files
are stored directly in the SQL database. Attachment size is the greatest factor in determining how

much space will be required in SQL.

To set up the maximum attachment size, select the Configuration component in the Perspective

Service Manager menu and open the Attachments tab.
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Perspective can support files up to 2 GB in size (SQL's limit for binary data types); however, due to
restrictions you may have on the space available for your Perspective database or bandwidth in
your network, we do include an option to decrease this 2-GB limit to a size that can be better

supported in your environment.

o On SQL Standard or Enterprise, this value can be set between 1 MB and 2000 MB. The
default is set to 250 MB.

o On SQL Express, this value can be set between 1 MB and 50 MB. The default is 10 MB.

To change this value to an appropriate value for your organization, move the slider.

/ Configuration I Chent-Side Configuration Noliicdimr_,} IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

Specify maximum allowed attachment zize for the chent.

S

M ax attachment size: 250 MB

[Upper limit is 2GB for SCIL Server 2005/2008 and SOMB for SOL Express)

Save Changes E st

Integration Services URL

1. To enable event trigger in Integration Services, select the Configuration component from

the Perspective Service Manager menu and open the Services tab.
2. Enter the URL set up with the Integration Services in the Integration Services field.

3. To enable trigger events on create and update, check the Enable Trigger Notification box.

To enable context-sensitive events, check the Allow Hot Key Events box.
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/" Configuration ] Client-Side Configuration ] Notification r Atachments /_ Services ] AE Tools ]

Integration Services
|https://staging ppm2000.com/Integration Services 30|

™ Enable Trigger Notfication [T Allow Hot Key Events

PPV PVV SOOI OOPIOIOIOISISOSe

g ®

Save Changes Exit

Custom Search Integration

With Perspective’s Custom Search feature, you can integrate Perspective with Infoglide Identity
Resolution Engine™ (IRE) to search several data sources at once. Complete the following steps to
enable this integration. Note that you must first configure your Perspective database within the

Identity Resolution Engine before proceeding.

To set up the Custom Search feature, select the Configuration component from the Perspective
Service Manager menu and open the Services tab. Check the Enable Custom Search (with
Infoglide) box and enter the URL for the Infoglide Identity Resolution Engine in the field below.

Note: To access the Custom Search feature, users must be granted the appropriate access rights in
Perspective. For details on administering Custom Search access for roles and users, see “Select
general role rights” and “Set general user rights” in the "Roles” and "Users” sections of the

Perspective Administrator’s Guide.
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/" Configuraion | Chent-Side Contiguration | Notiication | Asachments |/ Senvices | AETools |

begration Senvices
freps //Raging ppm 200 com. Integrmtion Senices

™ Enable Tegoer Nolfication ™ Ao Mot By Everts
¥ Enable Custom Search fwth Infoghde)
[t Pevees. e npeu cooed

A A A A A A

aave Changes e

Mass Notifications

In Perspective, users can integrate their MIR3¥ inEnterprise™ solution into Perspective in order to

send mass notifications about selected activities via Perspective DispatchLog.

To set up the Mass Notification feature, select the Configuration component from the
Perspective Service Manager menu and open the Services tab. Check the Enable Mass
Notification (with MIR3) box and enter the Mass Notification URL, Username and Password

provided by MIR3 in the field below.
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/Cmﬁguraﬁm rDim‘t-SdeCmﬁgumﬁon r-l'*.lotiﬁcaﬁm I/ﬁ.ﬂachmﬂs

EI/#ETmIs |

Integration Services

||'llpa.:,-’,-"5taging ppm2000.com/IntegrationSenvices30

I Enable Trigger Notfication ™ Allow Hot Key Events
™ Enable Custom Search {with Infoglide)"

¥ Enable Mass MNotification fwith MIR3)
Mass Motification U

||'ﬂp:fx’nwebservices mird.com/services/v1.2/mird

Usemame: |QATest
Password: I- TIIIL)

* Custom Search should not be enabled unless integrating an extemal search tool
from Infoglide to search several data sources at once.

Analysis Expert Tools

Save Changes Exit

If you experience difficulties with the correct Analysis Expert (AE) query display, this function must

be used to update the AE .dat file provided by Technical Support.

1.

Select the Configuration component from the Perspective Service Manager menu and open

the AE Tools tab.

Specify the SQL Server.

Select either the Windows or SQL Authentication. If you selected SQL Authentication, enter

the correct Username and Password.

Choose the Database you wish to update your queries on.

Specify the correct path to the AE .dat file provided by Technical Support in the File

Location field.

Click Update.
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Configuration I/CIierlt-Side Configuration I/Nntiﬁcation rﬁ.ﬂachments y/Servioes/AETonls

— Database Connection
SOL Server: |4EE-EGD1 R G

¥ Windows Authentication
SQL Authentication

Usemame: I

Passward: I

Databases: IPerspective j

B

— AE File Location

File Location: |"'-"'D|JI'I'I2DDI}| |
Update |

Save Changes Bt

Quick Find Indexing

With Perspective’s Quick Find tool, you can quickly search for text anywhere in the database,
including text within attachments. This works by scanning an index file generated on the server.

Quick Find Indexing supports the following file formats for attachments:

.doc, docx pdf Axt
.docm rtf .wpd
Jlog .sms Wps
.msg text Xls, xlsx

1.  To set up indexing on your database, select the Quick Find Indexing component in the
Perspective Service Manager menu.

2. To enable this feature, select Allow Quick Find.

3. Select an Index Directory to store the index files. The name of the index directory must end
with your organization’s business ID name (e.g. C:\Temp\[BusinessIDName]) and IIS must

have access to read this directory.
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Note: If you're using Perspective On Premise and your organization’s business ID is Default,
the index entry will end in Default (e.g. C:\Temp\Default).

4.  Optional: You can expect the Index file to be approximately 1/3 of your database size. If
storage on the local drive would be problematic, you can force the index cache to use a
separate directory by checking Specify folder in alternate drive to store cache while
indexing? and then selecting a directory.

5. Optional: If you would like certain common words to be ignored when indexing (e.g., a, the,
an, at, to, etc.), select Use noise word file? and specify the directory where your Noise.dat
file exists. Perspective does not provide a Noise.dat file.

6.  Optional: If you would like hyphenated words to be indexed as two separate words, you can
select Treat hyphens as spaces.

7. Optional: If you would like the index files to ignore any numeric text, you can select Do not

index numeric values.

8.  Expand the nodes listed under Tables and select each table you want data to be indexed
from individually. Note that attachments are indexed separately from the main entities and
can be found at the bottom of the list.

9. Click Save.
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Service Manager Settings

Database to Index

Perspective Service Manager

‘ Configuration
Database

Product Validation

| Quick Find Indexing

l

User Defined Fields

i Downloads

| Primary

v]

Allow Quick Find
Index Directory

CAlYour_Index_Path_Here]\[Your_Business_|D_Herg]

[] Specify folder in altemate drive to store cache while indexing?
Cache Drive/Directory

Use noise word file?

Path where noise word file exists.

clwindows\system32

[[] Treat hyphens as spaces.

[ Ignore numeric and date values

(== |

Browse

Entity/Column Selection
Select Al MNone
- [Wf] Activities ~

[ MNotes

Activ'rty ltems
| Category/ Type

| Male./ Madel
ftem MName
-[Jtem Value

-[] Serial Number

+|- || Activity Officer Responses

: [ Activity Organization Requests
+-[¥] Activity Organization Respanses
Activity Organizations

+ [w] Activity Person

J;--Activ'rty Person Clothing

i1 [l Arkivsitne Do Dl

Powered by dtSearch®  www dtsearch com

10. As data is added, deleted, or modified in the database, the index must be kept up-to-date.

You can perform full indexing or incremental indexing on a database by using the

Perspective.Indexer.exe program. To do this, open a Windows command prompt and

navigate to the Perspective Service Manager directory as follows:

cd “C:\Program Files\Resolver Inc\Perspective\5.2\ServiceManager”

11.  To perform full indexing on the default database, enter the following command:

Perspective.Indexer.exe

/c="C:\ [PerspectiveServicesPath]\Perspective5.2\PerspectiveServices\Perspec
tive Default.config"
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12.  To perform full indexing on a specific database, add the /d switch to the command:

Perspective.Indexer.exe
/c="C:\ [PerspectiveServicesPath] \Perspective5.2\PerspectiveServices\Perspec
tive Default.config" /d="database name”

13.  To perform incremental indexing on the default database, add the /i switch to the command:

Perspective.Indexer.exe
/c="C:\ [PerspectiveServicesPath]\Perspective5.2\PerspectiveServices\Perspec
tive Default.config" /i

14. To perform incremental indexing on a specific database, use the /d and /i switches:

Perspective.Indexer.exe
/c="C:\ [PerspectiveServicesPath] \Perspective5.2\PerspectiveServices\Perspec
tive Default.config" /d="database name” /i

15. Repeat steps 10-15 for every database you want to index.

16. There are other switches available when using Perspective.Indexer.exe. To view all of the

switches and their functions, enter the command Perspective.Indexer.exe ?

User Defined Fields

Although user defined fields (UDFs) can only be created by specialized users with access to both
the server machine and the Service Manager, they are maintained by Administrators in the same
manner as all other fields within Perspective. Visibility and access rights to a user defined field can
be controlled under System Privileges, Role Privileges or User Privileges. UDF labels can be
modified and created for other languages under Form Labels. Moreover, if the UDF is a lookup

field, lookup values and workgroup visibility for these values can be customized under Lookups.

You may add user defined fields to the Item, Person, Organization and Vehicle forms under the

General tab, as well as to numerous sections of the Incident and Case forms.
Note: The Case component is only available in the Premium Edition of Perspective.

1. To set up user defined fields for Perspective, select the User Defined Fields banner at the
bottom of the Perspective Service Manager menu and open the General tab.

2. From the Form lookup list, select the data form in which you would like the new user

defined field to appear. Your options are as follows:

e Incidents
e Incident Items (Involved ltems)

e Incident Organizations (Involved Organizations)
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e Incident > Persons (Involved Persons)
¢ Incident > Vehicles (Involved Vehicles)
e |tems

e Organizations

e Persons
e Vehicles
e C(Cases

e Activities

3. From the Section lookup list, select the specific section of the form that you would like the
user defined field to appear in. For all forms except Incidents and Cases, the only option
available is the General tab. For the Incidents form, you may choose the General,
Investigations (Details) or Controls tab. For the Cases form, you may choose either the
General or Controls tab.

4.  Click the Add button at the bottom of the window. An Add UDF dialog box will open.

5. Enter the new user defined field's name in the Field Name text box. Note that no special
characters or spaces may be used—letters only. Then, assign the field its default System
English Label. The System English label is what users will see on the Perspective form.

6. Choose the field type from the Data Type lookup list. The available field type options for
UDFs are Number (for whole numbers), Decimal Number (for numbers with up to two
decimal places), Text, Date, Yes/No (for a checkbox field) and Lookup List. If you selected
Text as the data type, you may also specify the maximum number of characters that can be

entered in the field under Text Length.
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Datal
|F‘rimary v‘ Primary Connection

Form Section
| Incidents v ‘ |Genem|

General | Layout

Field Name

User Defined Fields
[
@ Downloads

Please do not forget to restart the Perspective web Add UDF | | Edit UDF | ‘ Delete
server after making changes.

7.

Field Name

Data Type

| Lookup List

e To edit the user defined field, click the arrow to the left of the Field Name to select the
entire row and click the Edit button. Make changes in the Edit UDF dialog box and click

Apply.

e To delete the user defined field, click the arrow to the left of the Field Name to select
the entire row and click the Delete button. A Delete UDF confirmation window will open
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warning you of potential loss of data. If you choose to delete the selected UDF and click
Yes, any data previously tracked in the UDF will be erased as well. Instead, it's
recommended that you hide or lock the UDF within Perspective, if you no longer wish to
use it to track data.

8.  To view the user defined field with its default form location, select the Layout tab. The Top
and Left values indicate the number of pixels that the UDF will be located from the top left
corner of the User Defined Fields section of the form. The User Defined Fields section always
appears at the bottom of the form.

Form Section
IIr‘u:iu:Ient Perzonz j IGeneraI j

General | Layout

Default Layout Previous Layout | Save Layout £ I

e C(lick and drag the UDF label to move the UDF to an alternative location on the form.
The entire scrollable window beneath the Layout tab is representative of the User
Defined Fields section of the form. Click Save Layout to save the chosen UDF location

on the form.

e Atany time, you may click Default Layout to return the UDF to its original assigned

position on the form. To return the UDF to its last saved location, click Previous Layout.
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Troubleshooting Tips

Event Viewer

When an error occurs in your Perspective session, first check Event Viewer to see if it has been
recorded here.

1.  Go into Windows Event Viewer.
2. Click the Windows Logs folder.

3. Click the Application sub-folder. Most errors that have occurred in Perspective will be
logged here.

Perspective Server

@ Ensure Perspective Services is set up

1. Open lIS Manager, navigate to the Perspective Services Virtual Directory, and try to browse
the Service.asmx file.

2. If the page that is displayed reads “Service”, the install was successful.
If you get an error code page:

a. Check the properties of the Perspective Services Directory and ensure it is running under
Microsoft .NET 4.0 on the ASP.NET tab.

b. Re-install Microsoft .NET 4.0 with ISS using the following command line:
CA\WINDOWS\Microsoft. NET\Framework\v4.0.30319\aspnet_regiis.exe

% Connect to the database using ODBC

1. Select Control Panel > Administrative Tools > Data Sources (ODBC), and open the System
DSN tab.

2. Click Add to create a data source, select SQL Server. Click Finish.
3. Enter the name "Perspective” and select the name of your SQL Server.

4.  If your Perspective database is using SQL authentication, select the SQL server

authentication option and enter your SQL login credentials.
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5. Click Finish, and then click Test Data Source.
@ Test the application pool

An application pool is used to connect to the database server. To test if there is an issue with the
Web application pool, change the account to Network Services and see if it runs. If you are
using Windows Authentication for your Perspective database, change the application pool to the
same one used for your database. Reset the application pool, and then launch Perspective and
try to login.

@ Restart IIS

Right-click your Computer icon and select Manage. Expand the Services and Applications folder
and right-click Internet Information Services (IIS). Select All Tasks, then restart IIS and click OK.
Another way to restart IIS is to run the command line iisreset from the Start menu.

Database Server

% Ensure that the database login account has been assigned DBO access rights
1. In Enterprise Manager, select Security > Logins.

2. Double-click the domain user account that the Perspective server uses to connect to the
database (e.g., the test account “PerspectiveDBCon”).

3.  On the Database Access tab, select the Perspective database and ensure that dbo access is
assigned.

Reporting Services Server

For assistance and information on setting up SQL Reporting Services, view the deployment
guide on Microsoft's Web site: http://technet.microsoft.com/en-
us/library/ms159868(SQL.90).aspx

@ Check the version of the Microsoft .NET Framework

If NET Framework 3.5 is enabled on the machine, only client-side components of Reporting
Services will be installed. If necessary, remove the .NET Framework 3.5 before installing Reporting
Services, and re-install 3.5 afterwards using the following command line:

CAWINDOWS\Microsoft. NET\Framework\v2.0.50727\aspnet_regiis.exe
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@ Specify path for .bat file
1.  Using the Windows Start menu’s Search function, search for the rs.exe file.

2. Place a copy of the rs.exe file in the Perspective Install > Reports Setup folder.

Perspective Client

@ Connect to the Web site

Open your Web browser and enter the following URL:

https.//<servername >/PerspectiveServices/Service.asmx

% Ensure SQL login account is configured properly

The SQL login account (e.g., the test account “PerspectiveDBCon") needs permissions.
@ Troubleshoot Windows authentication issues

Note: Windows authentication is available for Perspective only and must be enabled through the
Perspective_default.config file. If you wish to use single sign-on for all Perspective modules
(Perspective, Dispatch, Dashboard, and/or Web Portal) you must enable SAML authentication.

1. Open the Perspective_default.config file. By default, this file is located at
C:\inetpub\wwwroot\Perspective5.2\PerspectiveServices.

2. Confirm the value in the <WindowsAuthentication> tag is set to true.

Note: You cannot enable both Windows authentication and SSO in the
Perspective_default.config file by changing the <§SOAuthentication> tag'’s value to true.

<MSReportServicellser:>

User_Domain_Mame;User_Login_Name;User_ Password</MSReportServicelser:»
<Perspectivefiuthentication>true</Perspectiveluthentication>
<WindowsAuthentication»false</WindowsAuthentication:
<550Authentication»false</S5048uthentications

<PartnerldentityProvider MName="" Description=""
3. In IS, open the Default Web Site and your Perspective Services site.
4, Double-click the Authentication icon.

5. Ensure that:

e Windows Authentication is enabled.

m © Resolver Inc. Confidential. Do not distribute. Page 52 of 69



Perspective Installation Guide Troubleshooting Tips

9.

e Anonymous Authentication is disabled.
Return to the previous screen and click Edit Permissions on the righ-side menu.

Open the Security tab, click Edit, and add appropriate Perspective Groups with View,
Read, and Execute permissions.

Reset IIS once you have completed the steps to ensure the changes take place.

Test logging in with a user who is set up for Windows Authentication in Perspective.

@ Troubleshoot application download issues

Using Command Prompt, you can remove cached data and uninstall Perspective from your

machine.

Note: Deleting this cached data will remove all ClickOnce data from your computer.

1.

Close all running applications. This will prevent the removal of the applications from the
App Cache.

Right-click the Start/Windows icon in the bottom-right corner of your screen.
Click Run.
Type or paste rundll32 dfshim CleanOnlineAppCache in the the Run dialog.

Click OK to run the command.

Note: Running this command will delete the contents of the 2.0 folder
(C:\Users\UserName\AppData\Local\Apps\2.0 and will remove all ClickOnce applications from

your computer.
Browse to the Perspective Services URL.
Click the Launch Perspective button to re-download the entire Perspective application.
Click Run to launch the Perspective application.

Log onto Perspective (see the Perspective Administrator’s Guide or Perspective User’s
Guide for more information on logging on). If the problem persists, please contact Resolver
Technical Support at 1-877-776-2995 for assistance.
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Error Messages

Error Message Explanation

No Connection. Perspective Client error

Solution
. Launch the Perspective client from the Perspective server and attempt to logon.

o Make sure the user account is a member of the [IS_WPG group on the Perspective server.

Response is not well formed .XML. Perspective Client error

Solution

. May be due to a missing bracket or other formatting issue in the
Perspective_Default.config file.

. May also be a permissions issue. See your local Security Policy.

Connection to the service not found/SQL )
] o Perspective Server error
Exception/Login failed for user.

Solution

Ensure the application pool account has access to the database. The account that the
Perspective server is using to connect to the database must be specified as the Application
Pool identity, and requires membership in the [IS_WPG.
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Contact Information

Technical Support

Toll Free: 1-877-776-2995

Phone: (780) 448-0616

Email: support@resolver.com
Website: https://support.resolver.com
Resolver

Toll Free: 1-888-776-9776

Phone: (780) 448-0616

Fax: (780) 448-0618

Email: information@resolver.com
Website: http://www.resolver.com
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Appendix A — Indexable Fields

Below is a complete list of the standard indexable fields that appear in Perspective and Service
Manager. Once indexed, these fields become searchable using the Quick Find tool in Perspective.

Note: Custom fields (also known as UDFs or user defined fields) can also be indexed so they
become searchable and appear in Service Manager.

| Section _____ Sub-Section(s) Field

Activities Activities Access Level
Activities Activities Activity Number
Activities Activities Activity Status
Activities Activities Address 1

Activities Activities Address 2

Activities Activities Call Source
Activities Activities Code

Activities Activities Contact Number
Activities Activities Description
Activities Activities Disposition
Activities Activities Notes

Activities Activities Officer Status
Activities Activities Organization Status
Activities Activities Postal Code
Activities Activities Priority

Activities Assignments Assignment Type
Activities Assignments Message/Task
Activities Activity > Items Category/Type
Activities Activity > Items Disposition
Activities Activity > Items [tem Name
Activities Activity > Items Item Value
Activities Activity > Items Linked Item
Activities Activity > Items Make/Model
Activities Activity > Items Notes

Activities Activity > Items Organization Owned By
Activities Activity > Items Person Owned By
Activities Activity > Items Serial Number
Activities Activity > Officer Responses Call Sign

Activities Activity > Officer Responses Officer Name
Activities Activity > Officer Responses Officer Response Notes
Activities Activity > Officer Responses OfficerStatus
Activities Activity > Organization Requests Comments
Activities Activity > Organization Requests Contact First Name
Activities Activity > Organization Request Contact Last Name
Activities Activity > Organization Requests Contact Middle Initial
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| Section | SubSection) __________________Feld

Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities

Activities

Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Person > Clothing
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Contact Person
Contact Phone
Involvement Type
Notified Type
Organization
Organization Name
Organization Number
Reference Number
Request Assigned To Person
Request Notes
Request Type
Tracking Number
Contact Last Name
Contact Middle Initial
Contact Person
Contact Phone
ContactFirstName
Involvement Type
Notified By Person
Notified Type
Organization
Organization Name
Organization Number
Organization Response Notes
Organization Type
OrganizationStatus
Reference Number
Responding Person
Comments

Contact First Name
Contact Last Name
Contact Middle Initial
Contact Person
Contact Phone
Involvement Type
Linked Organization
Notified By
Organization Name
Organization Number
Organization Type
Organization Webpage URL
Reference Number
Clothing Type
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| Section | SubSection) __ ________________Feld

Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities

Activity > Person > Clothing
Activity > Person > Clothing
Activity > Person Flags
Activity > Person > Injuries
Activity > Person > Injuries
Activity > Person > Injuries
Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles
Attachments

Attachments

Attachments

Attachments

Attachments

Call Category

Call Category

Call Category

Call Category
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Color

Description
Severity Level
Description

Injury Cause
Severity
Designation(s)
Employee Number
Eye Color

First Name

Flag Notes
Gender

Hair Color

Initial

Injured
Involvement Type
Last Name

Linked Person
Marital Status
Notes

Title

Color

Comments
Disposition
Driver Identified
Involvement Type
License Plate
Linked Vehicle
Make/Model
Plate Registered In
Style

Vehicle Value

VIN

Year

Attachment Title
Attachment Type
Description

File Extension

File Name

Call Category Name
Code

Level 1

Level 2
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| Section | SubSection) ___________________Feld

Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Cases

Cases

Cases

Cases

Cases

Cases

Cases

Call Category

Call Category

Involved Items

Involved Items

Involved Organizations
Involved Organizations
Involved Persons
Involved Vehicles
Involved Vehicles

Geo Rollups

Geo Rollups

Geo Rollups

Geo Rollups

Geo Rollups

Geo Rollups

Geo Rollups

Link Activities

Link Activities

Link Activities

Link Activities

Link Activity To Incident
Link Activity To Incident
Link Activity To Incident
Link Activity To Incident
Link Activity To Incident
Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Case > Assignments
Case > Assignments
Case > Assignments
Investigations
Investigations

Case > Investigation > Evidence Log

Case > Investigation > Evidence Log
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Level 3
Level 4
Item Category

Item Name

Organization Number

Organization Type
Gender

Incident Number
Make/Model

City

Country

Geo Rollup Name
Geo Rollup Name
Leveld

Rollup Level
State/Province
Link Type

Linked From Activity
Linked To Activity
Notes

Link Effective Date
Link Type

Linked From Activity
Linked To Incident
Notes

Address 1

Building

Location

Postal Code
Rollup Level

Site

Site Name

Site Notes

Site Rollup Name
Site Rollups
Threshold
Assignment Type
AttachmentFrom
Message/Task
Incident Number
Initiated By
Evidence Disposition

Evidence Log Status
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| Section | SubSectiony) ___________________Feld

Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases

Cases

Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Evidence Log > Status

Evidence Log > Status

Evidence Log > Status

Evidence Log > Status

Evidence Log > Status

Evidence Log > Status

Evidence Log > Status
CaselnvestigationinterviewHistory
CaselnvestigationinterviewHistory
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Log

Case > Investigation > Log

Case > Investigation > Log

Case > Investigation > Log

Case > Investigation > Log

Case > Investigation > Log

Case > Investigation > Summaries
Case > Investigation > Summaries
Case > Investigation > Summaries
Case > Investigation > Summaries

Case > Investigation > Summaries
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Evidence Name

Evidence Type
Evidence/Property From
Evidence/Property Tag
Found/Seized Location
Item Description

Notes

Organization Owned By
Owner Name Person
Person In Possession
Secured/Storage Location
Seized By Person

Seized From Person
Comments

Evidence Disposition
Status

Storage Location
Evidence/Property Tag
Person In Possession
Status Changed By Person
ChangedByPersonDescription
Reason

Attached Digital Interview
Interview Conducted by
Interview From

Interview Type

Location of Interview
Plain Text

Subject of Interview
Subject's Involvement Type
Witness

Word File

Expense Type

Log Notes

Logs From

Logs From

Task Done By Person
Task Type

Author Person

Plain Text

Summary From

Summary Type

Word File
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Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents

Incidents

CaselnvestigationSummaryHistory
CaselnvestigationSummaryHistory
Case > Investigators
Case > Investigators
Case > Investigators
CaseNarrativeHistory
Narratives

Case > Reviews

Case > Reviews

Cases

Cases

Cases

Cases

Cases

Cases

Cases

Cases

Case > Visibility

Case > Visibility

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Evidence Log > Status
Evidence Log > Status
Investigation > Interviews
Investigation > Interviews
Investigation > Interviews
Investigation > Interviews
Business Unit Rollups
Business Unit Rollups
Business Unit Rollups
Business Unit Rollups
Business Unit Rollups
Business Unit Rollups
Business Unit Rollups
Involved Items

Involved Items
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ChangedByPersonDescription
Reason

Comments
Investigator
Investigator Type
Reason

Word File
Comments

Review Type

Access Level

Case Category

Case Description
Case Name

Case Number
Disposition

Org Rollup

Status

All Workgroups
Owner Workgroup
Category

Class

Class Code

Class Name
Consequence

Rollup Level
Subcategory

Type

Class Rollup Name
Evidence Status
Person In Possession
Attached Digital Interview
Interview Conducted by
Interview Type

Plain Text

Business Unit Name
Business Unit Rollup Name
Level 1

Level 2

Level 3

Level 4

Rollup Level
Disposition

Incident Number
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| Section | SubSection) ___________________Feld

Incidents Involved Items

Incidents Involved Organizations

Incidents Involved Organizations

Incidents Involved Organizations

Incidents Involved Organizations

Incidents Involved Persons

Incidents Involved Persons

Incidents Involved Persons

Incidents Involved Persons

Incidents Involved Vehicles

Incidents Involved Vehicles

Incidents Involved Vehicles

Incidents Narratives

Incidents Narratives

Incidents Narratives

Incidents Narratives

Incidents Incident > Assignments

Incidents Incident > Assignments

Incidents Incident > Assignments

Incidents Incident > Assignments

Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Incident > Investigation > Evidence Log
Incidents Evidence Log > Status

Incidents Evidence Log > Status

Incidents Evidence Log > Status

Incidents Evidence Log > Status

Incidents Evidence Log > Status

Incidents IncidentinvestigationinterviewHistory
Incidents IncidentinvestigationinterviewHistory
Incidents Investigation > Interviews

Incidents Investigation > Interviews

Incidents Investigation > Interviews

m © Resolver Inc. Confidential. Do not distribute.

Loss Type

Incident Number
Involvement Type
Notified By

Organization Name

First Name

Incident Number
Involvement Type

Last Name

License Plate

Vehicle Involvement Type
Vehicle Year

Author

Narrative From

Narrative Type

Plain Text

Assigned By Person
Assigned To Person
Assignment Type
Message/Task
Disposition

Evidence Status
Evidence/Property Name
Evidence/Property Tag
Evidence/Property Type
Incident ID

Notes

Owner Name Organization
Owner Name Person
Person In Possession
Secured/Storage Location
Seized By Person

Seized From Person
Disposition
Evidence/Property Tag
Reason for Status Change
Status Changed By Person
Storage Location
ChangedByPersonDescription
Reason

Incident ID

Location of Interview

Subject of Interview
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| Section | SubSection) __________________Feld

Incidents Investigation > Interviews

Incidents Investigation > Interviews

Incidents Investigation > Interviews

Incidents Incident > Investigation > Log
Incidents Incident > Investigation > Log
Incidents Incident > Investigation > Log
Incidents Incident > Investigation > Log
Incidents Incident > Investigation > Log
Incidents Incident > Investigation > Summaries
Incidents Incident > Investigation > Summaries
Incidents Incident > Investigation > Summaries
Incidents Incident > Investigation > Summaries
Incidents Incident > Investigation > Summaries
Incidents IncidentinvestigationSummaryHistory
Incidents IncidentinvestigationSummaryHistory
Incidents Incident > Investigators

Incidents Incident > Investigators

Incidents Incident > Investigators

Incidents Incident > Investigators

Incidents Incident > Items

Incidents Incident > Items

Incidents Incident > Items

Incidents Incident > Items

Incidents Incident > Items

Incidents Incident > Items

Incidents Incident > Items

Incidents Incident > Items

Incidents Incident > Items

Incidents Incident > Items

Incidents IncidentNarrativeHistory

Incidents IncidentNarrativeHistory

Incidents Incident > Narratives

Incidents Incident > Narratives

Incidents Incident > Narratives

Incidents Incident > Narratives

Incidents Incident > Narratives

Incidents Incident > Organization > Requests
Incidents Incident > Organization > Requests
Incidents Incident > Organization > Requests
Incidents Incident > Organization > Requests
Incidents Incident > Organization > Responses
Incidents Incident > Organization > Responses
Incidents Incident > Organization > Responses
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Subject's Involvement Type
Witness

Word File

Expense Type
Incident ID

Log Notes

Task Done By Person
Task Type

Word File

Author

Incident

Plain Text

Summary Type
ChangedByPersonDescription
Reason

Comments

Incident ID
Investigator
Investigator Type
Category/Type
Disposition

ltem Name

Item Value

Linked Item
Make/Model

Notes

Organization Owned By
Person Owned By
Serial Number
PersonDescription
Reason

Author
IncidentNumber
Narrative

Narrative Type

Plain Text

Request Assigned To Person
Notes

Tracking Number
Request Type
Notified By Person
Responding Person

Response Notes
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Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents

Incidents

Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations
Incident > Organizations

Incident > Owner > History
Incident > Owner > History
Incident > Owner > History
Incident > Person > Clothing
Incident > Person > Clothing
Incident > Person > Clothing

Incident > Person > Flags

Incident > Person > Injuries
Incident > Person > Injuries
Incident > Person > Injuries

Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Persons
Incident > Reviews
Incident > Reviews
Incident > Reviews

Incidents
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Comments
Contact First Name
Contact Last Name

Contact Middle Initial

Contact Person
Contact Phone
Involvement Type
Linked Organization
Notified By
Organization Name

Organization Number

Organization Type

Organization Webpage URL

Reference Number
Comments

Owner Person
Owner Added Date
Clothing Type
Color

Description
Severity Level
Description

Injury Cause
Severity
Designation(s)
Employee Number
Eye Color

First Name

Flag Notes

Gender

Hair Color

Initial

Involvement Type
Last Name

Linked Person
Marital Status
Notes

Reviewed By Person
Title

Comments
Reviewed By Person
Review Type

Access Level

Page 64 of 69



Perspective Installation Guide

Appendix A — Indexable Fields

| Section | SubSection) ___________________Feld

Incidents Incidents AttachmentCount
Incidents Incidents Corrective Action Summary
Incidents Incidents Disposition

Incidents Incidents Division Reported To
Incidents Incidents e-Incident Number
Incidents Incidents File Number
Incidents Incidents Flag Notes

Incidents Incidents Follow-up Required
Incidents Incidents Incident Duration
Incidents Incidents Incident Number
Incidents Incidents Investigation Comments
Incidents Incidents Investigation Duration
Incidents Incidents Police File Number
Incidents Incidents Policy Affected
Incidents Incidents Policy Name:
Incidents Incidents Primary Cause
Incidents Incidents Reported to Division
Incidents Incidents Reported to Police
Incidents Incidents Reported to Supervisor
Incidents Incidents Secondary Cause
Incidents Incidents Status

Incidents Incidents Summary

Incidents Incident > Vehicles Color

Incidents Incident > Vehicles Comments

Incidents Incident > Vehicles Disposition

Incidents Incident > Vehicles Driver Identified
Incidents Incident > Vehicles Incident ID

Incidents Incident > Vehicles Involvement Type
Incidents Incident > Vehicles License Plate
Incidents Incident > Vehicles Linked Vehicle
Incidents Incident > Vehicles Make/Model
Incidents Incident > Vehicles Plate Registered In
Incidents Incident > Vehicles Style

Incidents Incident > Vehicles Vehicle Driver
Incidents Incident > Vehicles VIN

Incidents Incident > Vehicles Year

Incidents Link > Incidents Link Type

Incidents Link > Incidents Linked From Incident
Incidents Link > Incidents Linked To Incident
Incidents Link > Incidents Notes

Incidents Link Incident To Case Case Number
Incidents Link Incident To Case Link Incident To Case
Incidents Link Incident To Case Link Type
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| Section | SubSection) __________________Feld

Incidents Link Incident To Case Notes

Incidents Link Incident To Case > Detail Building

Incidents Link Incident To Case > Detail Category

Incidents Link Incident To Case > Detail Class

Incidents Link Incident To Case > Detail Incident Status
Incidents Link Incident To Case > Detail Link Incident To Case
Incidents Link Incident To Case > Detail Link Type

Incidents Link Incident To Case > Detail Site

Incidents Link Incident To Case > Detail Summary

Incidents Link Incident To Incident > Detail Building

Incidents Link Incident To Incident > Detail Category

Incidents Link Incident To Incident > Detail Class

Incidents Link Incident To Incident > Detail Incident Status
Incidents Link Incident To Incident > Detail Link Incident Number
Incidents Link Incident To Incident > Detail Site

Incidents Link Incident To Incident > Detail Summary

Incidents Site Rollups Address 2

Incidents Site Rollups Section

Items Item > Class Rollups Item Category

Items Item > Class Rollups Item Class Name

Items Item > Class Rollups Item Class Rollup Name
Items Item > Class Rollups ltem Type

Items Item > Class Rollups Level3

Items Item > Class Rollups Level4

Items Item > Class Rollups Rollup Level

Items Item Make Model Rollups Item Make

Items Iltem Make Model Rollups Item Make Model Name
Items Item Make Model Rollups I’;cli:\;\/lake Model Rollup
Items Item Make Model Rollups ltem Model

Items Item Make Model Rollups Level3

Items Iltem Make Model Rollups Leveld

Items Item Make Model Rollups Rollup Level

Iltems Iltems Access Level

Items Items Item Class Rollup

Items Items Item Make Model Rollup
Iltems Iltems ltem Name

Items Iltems Notes

Items Items Owner Identified

Items Items Owner Name Organization
Iltems Iltems Owner Name Person
Items Items Serial Number
Organizations Link Persons Linked To Person
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Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons

Persons

Link Persons

Link Person To Organization
Link Person To Organization
Link Person To Organization
Link Person To Organization
Link Vehicles

Organization > Addresses
Organization > Addresses
Organization > Addresses
Organization > Addresses
Organization > Addresses
Organization > Addresses
Organization > Email Addresses
Organization > Email Addresses
Organization > Email Addresses
Organization > Phone Numbers
Organization > Phone Numbers
Organization > Phone Numbers
Organizations

Organizations

Organizations

Organizations

Organizations

Organizations

Organizational Rollups
Organizational Rollups
Organizational Rollups
Organizational Rollups
Organizational Rollups

Link Organizations

Link Organizations

Link Organizations

Link Vehicles

Link Vehicles

Link Vehicles

Person > Addresses

Person > Addresses

Person > Addresses

Person > Addresses

Person > Addresses

Person > Email Addresses
Person > Email Addresses

Unique Features
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Link Type

Link Type

Notes

Organization
Person

Notes

Address 1

Address 2
Geographic Rollup
Organization ID
Type

Zip/Postal Code
Email Address
Organization ID
Type

Organization ID
Phone Number
Type

Access Level

Notes

Organization Name
Organization Number
Organization Type
Organization Webpage URL
Org Level 1

Org Level 2

Org Level 3

Org Level 4

Org Rollup Name
Link Type

Linked From Organization
Linked To Organization
Link Type

Linked From Vehicle
Linked To Vehicle
Address 1

Address 2

Address Type
Geographic Rollup
Zip/Postal Code
Email Address

Email Type

Description
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Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Vehicles
Vebhicles
Vebhicles
Vehicles
Vehicles
Vebhicles
Vehicles
Vehicles
Vebhicles
Vebhicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles

Vehicles

Unique Features

Unique Features

Person > Flag List

Person > Flag List

Person > Flags

Identification

Identification

Identification

Identification

Person > Phone Number
Person > Phone Number
Persons

Persons

Persons

Persons

Persons

Persons

Persons

Persons

Persons

Persons

Persons

Persons

Persons

Person > Trespasses

Person > Trespasses

Link > Organizations

Link Organization To Vehicle
Link Organization To Vehicle
Link Organization To Vehicle
Link Organization To Vehicle
Link Persons

Link Persons

Link Person To Vehicle

Link Person To Vehicle

Link Person To Vehicle

Link Person To Vehicle

Vehicle > Make Model Rollups
Vehicle > Make Model Rollups
Vehicle > Make Model Rollups
Vehicle > Make Model Rollups
Vehicle > Make Model Rollups
Vehicle > Make Model Rollups

E © Resolver Inc. Confidential. Do not distribute.

Feature Type
Location

Flag Description
Letter Code
Severity

Comments
Identification Number
Identification Type
Issued By

Phone Number
Phone Type

Access Level
Additional Information
Designation
Employee
Employee Number
Eye Color

First Name

Flag Notes

Gender

Hair Color

Initial

Last Name

Title

Comments

Site Rollup

Notes

Link Type

Notes

Organization
Vehicle

Linked From Person
Notes

Link Type

Notes

Person

Vehicle

Make

Model

Rollup Level

Rollup Name
Vehicle Make Model Name
Vehicle Make Model Rollups
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| Section | Sub-Section(s) Field

Vehicles Vehicles Access Level
Vehicles Vehicles Branch

Vehicles Vehicles Color

Vehicles Vehicles Comments
Vehicles Vehicles Company Vehicle
Vehicles Vehicles Division

Vehicles Vehicles Geographic Rollup
Vehicles Vehicles License Plate
Vehicles Vehicles Photo

Vehicles Vehicles Style

Vehicles Vehicles Vehicle Make/Model
Vehicles Vehicles Vehicle Value
Vehicles Vehicles VIN

Vehicles Vehicles Year
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